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Enable Project Expenditure Types for Expense Report Entry

Project Billing Super User: Setup > Expenditures > Expenditure Types 
Description: Enable expenditure types to be used on project-related expense reports. Enable selected expenditure types with an Expenditure Type Class ‘Expense Reports’. You need to associate these expenditure types with Expense Type you define in the Expese Report Template.

DO NOT SET UP MILEAGE EXPENDITURE TYPE WITH UNIT OF MEASURE MILES! Mileage expenses imported from iExpenses > Payables > Projects will be imported in dollars, or whatever the currency may be. Make sure you set up mileage expenditure types used by iExpenses with a unit of measure ‘Currency’.
AP: Define Expense Report Templates

Payables Manager: Setup > Invoice > Expense Report Template
Description: You must define at least one expense report template with the Enable for Internet Expenses Users check box selected. Only expense report templates with this option enabled can be used in Internet Expenses. Use the Oracle Payables Expense Report Templates window to define your expense report templates.

	Oracle Field
	Value
	Notes

	
	
	

	Template Name
	
	

	Description
	
	

	Enable for Internet Expenses 
	Yes
	

	Expense Items

	
	
	
	
	
	
	

	Expense Item
	Expense Category
	GL Account
	PA Exp Type
	Receipt Above
	Justification

Required

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


AP: Define Financials Options

Payables Manager: Setup > Options > Financials
AP: Set Expense Check Reimbursement Address

Description: Use the Payables Financials Options window to define the expense report reimbursement check setup. By default, Internet Expenses uses the home or office value defined in the HRMS Mail To setup, if there is one. If not, then Internet Expenses uses the value you define in the Payables Financials Options window. This setting also provides the value to use to create the supplier site record, if you enable the Automatically Create Employee as Supplier option in the Payables Options window.

You can define employee home and office addresses either in the People window, if you have a full install of Oracle Human Resources, or in the Enter Person window in Oracle Payables.  To set the default expense check address:

AP: Define Expenses Clearing Account

Description: You define the Expense Clearing Account in the Oracle Payables Financials Options window. Payables uses this as a temporary account to record information about

credit card transactions when processing expense reports created in Internet Expenses. This step is only necessary if you are implementing the Company Pay reimbursement policy.

Note: The Expense Clearing Account field is also available in the Card Program window. If you define the Expense Clearing Account field in the Card Program window, the value you define there will take precedence over the value in the Oracle Payables Financial Options window.

	Option
	Value
	Notes

	
	
	

	Accounting

	
Expense Clearing
	
	

	Human Resources

	
Business Group
	
	

	
Expense Reimbursement Address
	
	

	Use Approval Hierarchies
	
	

	Employee Numbering: Method
	
	

	Next Automatic Number
	
	

	
	
	


AP: Define Payables Options

Payables Manager: Setup > Options > Payables

AP: Establish Multiple Currencies Setup

Description: The currency in which an expense report is paid is known as the reimbursement currency. Internet Expenses users can specify a reimbursement currency that is different from your company functional currency only if: 

· Oracle Payables is set up for multiple currencies.

· Reimbursement currency is enabled in the Currencies window.

· OIE: Allow Non-Base Pay profile option is set to Yes. 

AP: Defining Expense Report Options

Description: The Expense Report tabbed region of the Payables Options window controls certain aspects of the expense reporting process in Payables. Review these settings to become more familiar with them and understand how they affect the expense reporting process.

Default Template. The default expense report template that you want to use in the Payables Expense Reports window. You can override this value in the Expense Reports window. A default expense report template appears in the Expense Reports window only if the expense report template is active.

Payment Terms. Payment terms you want to assign to any suppliers that you create from employees during Expense Report Import.

Suggestion: Define and assign immediate payment terms for your employee suppliers.

Pay Group. Pay Group you want to assign to any suppliers that you create from employees during Expense Report Import. You can define additional values for Pay Group in the Purchasing Lookups window.

Payment Priority. Payment priority you want to assign to any suppliers that you create from employees during Expense Report Import. A number, between 1 (high) and 99 (low), which represents the priority of payment for a supplier. 

Apply Advances. Default value for the Apply Advances option in the Expense Reports window in Payables. If you enable this option, Payables applies advances to employee expense reports if the employee has any outstanding, available advances. You can override this default during expense report entry.

Automatically Create Employee as Supplier. If you enable this option, when you import Payables expense reports, Payables automatically creates a supplier for any expense report where an employee does not already exist as a supplier. If the supplier site you are paying (HOME or OFFICE) does not yet exist, Payables adds the supplier site to an existing supplier. Payables creates a HOME or OFFICE supplier site with the appropriate address, depending on where you are paying the expense report. The Home address is from the PER_ADDRESSES table, and the Office address is from the HR_LOCATIONS table. Payables creates suppliers based on the defaults you select in this region and employee information from the Enter Person window. You can review suppliers and adjust any defaults in the Suppliers window.

If you do not enable this option, enter an employee as a supplier in the Suppliers window and link the Employee Name/Number to the supplier before you use Expense Report Import. Payables cannot import expense reports without corresponding suppliers, and lists them on the Exceptions section of the Expense Report Import Report.

Hold Unmatched Expense Reports. This option defaults to the Hold Unmatched Invoices option for the supplier and supplier site for any suppliers Payables creates during Expense Report Import.

When Hold Unmatched Invoices for a supplier site is enabled, Payables requires that you match each invoice for the supplier site to either a purchase order or receipt. If you enable this option for a site, then Payables applies a Matching Required hold to an invoice if it has Item type distributions that are not matched to a purchase order or receipt. Payables applies the hold to the invoice during Invoice Validation. You cannot pay the invoice until you release the hold. You can release this hold by matching the invoice to a purchase order or receipt and resubmitting Invoice Validation, or you can manually release the hold in the Holds window of the Invoice Workbench. Payables will not apply a hold if the sum of the invoice distributions by accounting code combination is zero.
	Option
	Value
	Notes

	
	
	

	Currency

	
Use Multiple Currencies
	
	

	Require Exchange Rate Entry
	
	

	Calculate User Exchange Rate
	
	

	Expense Report

	
Default Template
	
	

	Payment Terms
	IMMEDIATE
	

	Pay Group
	EMPLOYEES
	

	Payment Priority
	50
	

	Apply Advances
	No
	

	Automatically Create Employee as Supplier
	Yes
	

	Hold Unmatched Expense Reports
	No
	

	
	
	


Assign Signing Limits

Payables Manager: Employees > Signing Limits
Description: Managers can approve an expense report only if the total amount of the report does not exceed their signing limit. The Manager (Spending) Approval Process in the Expense Reporting workflow uses the signing limits you define to determine whether managers have authority to approve expense reports. When you assign signing limits to a manager, you specify a cost center to which the signing limit applies. You can also give managers signing limits for multiple cost centers.

To assign signing limits:

1. Navigate to the Employee Signing Limits window.

2. Select AP Expense Report as the document type.

3. Enter the name of the manager to whom you want to assign a signing limit in the Employee Name field, or choose from the list of values.

4. Enter the cost center for which you want this manager to approve expense reports, or choose from the list of values.

5. Enter a signing limit for this manager.

6. Repeat steps 3 - 5 if you want this manager to be able to approve expense reports for more than one cost center.

7. Save your work.

Define iExpense Policies
Internet Expenses Setup and Administration: Internet Expenses Setup > Policy > Expense Fields
Set Up Required Expense Fields
You can set up additional fields that apply either to an expense category or to individual expense types. When a user chooses an expense type that is assigned an additional field rule, or is assigned to an expense category with additional field definitions, the defined fields appear in the Additional Information section of the Expense Line Details page.
	Accommodations

	End Date
	Enabled

	Merchant
	Required

	Airfare

	Merchant
	Required

	Class of Ticket
	Enabled

	Ticket Number
	Enabled

	From Location
	Required

	To Location
	Required

	Car Rental

	Merchant
	Required

	Meals

	Number of Attendees
	Enabled

	Attendees
	Required

	Mileage

	Leave defaults
	


Enable Expense Allocations

Internet Expenses Setup and Administration: Internet Expenses Setup > Accounting > Define

Set up Internet Expenses to allow updating and validation of accounting flexfield segments for individual expense lines. When enabled, users can update the accounting flexfield segment assignments on the individual expense lines of their expense reports. This is useful, for example, for users who consistently charge expenses to accounts that are not a part of their usual accounting. Internet Expenses can provide automatic validation of the account code combinations that users enter. Managers can review the account code combinations on expense reports. There are two tasks to complete for setting up expense allocations:

· Use the Internet Expenses Setup responsibility to set up accounting flexfield behavior for your company charts of accounts. For each chart of accounts, you define which segments of the accounting flexfield are visible on expense lines, and which of the displayed segments are updatable by the user.

· Use the OIE: Enable Expense Allocations profile option to enable expense allocations according to your requirements. You can set the display of accounting flexfield segments and online validation as user-definable or automatic. When enabled, automatically or by the user, an additional page called Expense Allocations appears on the expenses entry pages just before the Review page. On this page the user can update accounting flexfield segments for either a single expense line or a group of expense lines.

Set status as follows:

	Segment
	Status

	Company
	Enabled

	Department
	Enabled

	Account
	Read-Only

	Future
	Disabled

	Intercompany
	Disabled


Define Receipt Notification Rule Set

Internet Expenses Setup and Administration: Internet Expenses Setup > Audit > Notification Rules

Create a new Notification Rule Set as follows:

	Field name
	Value

	Rule Set Name
	Receipts Notifications

	Description
	Receipts Notifications

	Notify Individual
	When Receipts are received

	Overdue Receipts Notifications

	Receipts overdue or missing after expense report submitted
	14

	Subsequent notifications if receipts still overdue
	7

	Receipts considered overdue or missing after user response
	7

	Receipt document required if user indicates receipts are missing
	Yes

	
	


Assign Receipt Notification Rule Set

Internet Expenses Setup and Administration: Internet Expenses Setup > Audit > Notification Rule Assignments

Click ‘Update’ for Operation Unit Your Company OU. Use the Notification rule set assignments pages to assign the notification rule sets that you created to the operating units that you want. The notification rule set that you assign to an operating unit remains active during the effective period that you specify. If you do not enter an end date, then the notification rule set remains active indefinitely. To change notification behavior for an operating unit, you must apply an end date to the current notification rule set, and then assign a new notification rule set. 

When a notification rule set is assigned to an operating unit, Internet Expenses compares the expense report submission date to the system date to initially determine if receipts are overdue on an expense report. For all expense reports that have overdue receipts, Internet Expenses initiates the process of sending notifications, according to the notification rules.

You must assign a notification rule set to an operating unit to make use of notification rules. If an operating unit does not have a notification rule set assignment, then the Overdue Expense Receipts Tracking concurrent program cannot detect overdue or missing receipts, and therefore cannot call the Expense Receipts workflow.

	Field name
	Value

	Rule Set Name
	Receipts Notifications

	Effective Start Date
	01/01/2005


Define Mileage Rate Schedule
Internet Expenses Setup and Administration: Internet Expenses Setup > Policy > Schedules > Mileage

· Click ‘Create New Schedule’. Populate required fields as follows:
	
Field Name
	Value

	Schedule Name
	

	Description
	

	Distance Unit of Measure
	Miles

	Start Date
	

	Currency Rules
	

	
	


· Leave all Optional Rules blank. Click ‘Next’.

· Currency = ‘USD’. Allow rate Conversion.

· In the Update Mileage Rate Schedule: Periods and Rates, click ‘Details’.
· Enter Mileage Rate = 0.485

· Click Apply.
· Click Activate.
Complete Mileage Expense Type Definition in Payables
Payables Manager > Setup > Invoice > Expense Report Templates
· Find the expenses template

· Find the mileage expense type.

· Assign the Mileage Schedule.
SA: Define Profile Options
System Administration:  Profile > System

Description:  Use this form to define profile options.
OIE: Allow Credit Lines

Set the OIE: Allow Credit Lines profile option to Yes to enable users to enter negative receipts (credit lines). Users enter negative receipts to report the refund of a previously reimbursed expense, for example, an unused airline ticket. Setting this profile option to No prevents users from entering negative expense lines for cash and other expenses. Users can still enter negative corporate credit card expense lines. The default value is Yes.

OIE: Enable Credit Card

Set the OIE: Enable Credit Card profile option to Yes to enable the credit card functionality to allow users with corporate credit cards to select and add credit card transactions to their expense reports.

OIE: Allow Non-Base Pay

Set the OIE: Allow Non-Base Pay profile option to Yes to enable users to choose the reimbursement currency for their expense reports. You must set up Payables to use multiple currencies before you can enable this profile option. 

OIE: CC Approver Req

The OIE: CC Approver Req profile option indicates whether users must enter an alternate approver when they charge their expense reports to a cost center different from their own. Set the OIE: CC Approver Req profile option to Yes to require employees to enter the Alternate Approver field when employees enter a cost center other than their default cost center. If you set this profile option to Yes, you must also set the OIE: Enable Approver profile option to Yes.

OIE: CC Payment Notify

Use the OIE: CC Payment Notify profile option to specify whether a notification is sent to employees when payment is created in Oracle Payables for corporate credit card transactions. The default value is No.

OIE: Enable DescFlex

The OIE: Enable DescFlex profile option enables Internet Expenses to display descriptive flexfields. You must set up descriptive flexfields specifically for use in Internet Expenses before you can enable this option.

OIE: Enable Projects

The OIE: Enable Projects profile option enables users to enter project-related information on expense reports. You must set up Internet Expenses to integrate with Oracle Projects before you can enable this option.

The values for this profile option are:

– Yes - Enables the entry of project information.

– No - Disables the entry of project information.

– Required - Requires the entry of project information.

OIE: Enable Tax

The OIE: Enable Tax profile option enables the availability of tax-related elements on expense reports. Set this profile option to Yes to display the Tax Code field and Amount Includes Tax check box on expense reports. Set this profile option to No to conceal the display. If you set this profile option to No and you set up tax calculation on expense reports, Internet Expenses uses the default values you provide without user intervention. 

OIE: Enable Approver

The OIE: Enable Approver profile option enables the Alternate Approver field in Internet Expenses. When this profile option is set to Yes, the Alternate Approver field is available for users to specify a different employee to approve their expense report. When this profile option is set to No, the Alternate Approver field is hidden.

OIE: Approver Required

The OIE: Approver Required profile option indicates whether users must designate an approver for their expense reports. If you set the OIE: Approver Required profile option to Yes, Internet Expenses requires that users always enter an alternate approver. If you set this profile option to Yes with Default, the employee’s supervisor, as defined in Oracle HRMS, will be provided for the user.

Attention: You must set the OIE: Enable Approver profile option to Yes if you want to use one of the three seeded Find Approver methods.

OIE: Purpose Required

The OIE: Purpose Required profile option controls whether users must enter a purpose when creating an expense report. A purpose is a brief description of the business activities that justify the expenses in a report. 

OIE: Report Number Prefix

The OIE: Report Number Prefix profile option specifies a prefix value for expense report numbers. The expense report number becomes the corresponding invoice number when the expense report is converted into an invoice via the Expense Report Import program. Entering a prefix value enables you to easily identify invoices in Payables that were expense reports created in Internet Expenses. Leave this option blank if you do not want to specify a prefix value for expense report numbers. For example, if you set the OIE: Report Number Prefix profile option to use the prefix Web, your expense report numbering appears as Web589, Web560, Web561, and so on.

OIE: Grace Period

The OIE: Grace Period profile option specifies the number of grace period days beyond an end date that certain OIE setup items remain available for use. The OIE setup items are: 

· Rate schedules

· Rate schedule rule values that have end dates

· Location records

· Expense report template Inactive On field

· Expense types

These items remain available for selection and use as long as the system date is before the end date plus the number of grace period days. The default value is 30.

OIE: Enable Policy

The OIE: Enable Policy profile option controls the behavior of Internet Expenses in relation to reports that contain policy violations. If an expense report is submitted with violations, Internet Expenses captures policy violations for reporting purposes. The values are: 

· Prevent Submission - The end user cannot submit the expense report. All monetary violations that exceed tolerances result in preventing report submission, including the exchange rate policy (the exchange rate tolerance is the exchange rate limit). An error message informs the user of the policy violation. For more information, see Tolerance Limits. For all non-monetary policy violations, and for monetary violations that do not exceed tolerances, the behavior is the same as the Warn Users option (users receive a warning but can submit the expense report). 

· Warn Users - The end user can submit the expense report. A warning message informs the user that the report contains policy violations. This includes non-monetary policy violations and monetary policy violations where the violation is below the limit + threshold.

· Inform Approvers - The end user can submit the expense report. If there are policy violations, they are transparent to the end user, but Internet Expenses documents the violations for approvers. The default value is Inform Approvers. 

OIE: Enable Expense Allocations

The OIE: Enable Expense Allocations profile option determines whether an end user can update the cost center segment value on an expense line. If set to Yes, an employee can split expense reports across cost centers, for both credit card expenses and cash and other expenses. The default value is No.

PA: Allow Project Time and Expense Entry

The PA: Allow Project Time and Expense Entry profile option enables users to enter project-related information on expense reports. If you set this option to Yes, then you must set the OIE: Enable Projects profile option to Yes as well. You must set up Internet Expenses to integrate with Oracle Projects before you can enable this option. 

PA: AutoApprove Expense Reports

The PA: AutoApprove Expense Reports profile option permits automatic approval of project-related expense reports.

Journals: Display Inverse Rate

The Journals: Display Inverse Rate profile option determines how the reimbursable amount is calculated when users enter foreign currency receipts. When this profile option is set to No, the receipt amount is multiplied by the exchange rate to determine the reimbursable amount. When it is set to Yes, the receipt amount is divided by the exchange rate. The default value is No. 

AME: Installed

The AME: Installed profile option enables the integration between Internet Expenses and Oracle Approvals Management.

WF: Notification Reassign Mode

The WF: Notification Reassign Mode profile option determines the forwarding functionality that is available to employees. If you set the WF: Notification Reassign Mode profile option to ‘Reassign’, employees see the Reassign button on the notification. Clicking the Reassign button lets employees choose between transferring or delegating that notification. 

If you set the FND: Notification Reassign Mode profile option to Delegate, employees will see the Delegate button. When employees click the Delegate button and enter an employee name, the notification is delegated to that employee that is entered. When a notification is delegated to employees the notification is forwarded to the delegated employee, but the original recipient of the notification remains the owner. 

If you set this option to Transfer, employees will see the Transfer button. When employees click the Transfer button and enter an employee name the notification is transferred to that employee that is entered. When a notification is transferred, the notification is forwarded and the new recipient becomes the owner of the notification.

WF: Mailer Cancellation Email

The WF: Mailer Cancellation Email profile option enables the functionality that sends the cancellation notifications when time outs are reached for a notification and a new notification is sent because of resend setup. If you set this profile option to Enabled, cancellation notifications are sent. If you set this profile option to Disabled, cancellation notifications are not sent. 

Personalize Self-Service Defn

The Personalize Self-Service Defn profile option enables the Oracle Applications Personalization Framework in Internet Expenses. If you set this profile option to Yes, then the OA Personalization Framework is available to expenses administrators to configure the Internet Expenses user interface.

Account Generator: Run in Debug Mode
	Profile
	Site
	Application
	iExpenses Responsibility

	OIE: Allow Credit Lines
	Yes
	
	

	OIE:Allow Non-Base Pay
	
	
	

	OIE:Approver Required
	Yes
	
	Yes

	OIE:CC Approver Req
	
	
	

	OIE:CC Payment Notify
	
	
	

	OIE:Enable Approver
	Yes
	
	

	OIE:Enable Credit Card
	
	
	

	OIE:Enable DescFlex
	
	
	

	OIE:Enable Expense Allocations
	User-enabled, with Online Validation
	
	

	OIE:Enable Policy
	
	
	

	OIE:Enable Projects
	Yes
	
	

	OIE:Enable Tax
	No
	
	

	OIE:Grace Period
	30
	
	

	OIE:Purpose Required
	Yes
	
	

	OIE:Report Number Prefix
	EXP-
	
	

	PA: Allow Project Time and Expense Entry
	Yes
	
	

	PA: AutoApprove Expense Reports
	
	
	

	AME:Installed
	Enabling this option disables Workflow approvals!
	
	

	Automated Escalation Notification Task Assignee Role
	Unassigned
	
	Document Owner

	WF: Notification Reassign Mode
	Delegate
	
	

	WF: Mailer Cancellation Email
	Enabled
	
	

	Personalize Self-Service Defn
	Enable temporarily to customize iExpense instructions and prompts
	
	

	
	
	
	


System Administration Integration
1. All people to receive workflow notification must be valid Oracle users with an email address

2. Run the Synchronize Local WF Tables process every time you make changes to user setup. 
Customize the Internet Expenses Workflow 
Define a new OIEADMIN Role
As System Administrator: complete these steps:

· Create a new Oracle user 

	Field Name
	Value

	Name
	OIEADMIN

	Description
	Oracle iExpenses Administrator

	Email
	OIEADMIN@YourDomain.com

	Assigned Responsibilities
	· Workflow User Web Applications
· Internet Expenses Setup and Administration
· Internet Expenses Auditor

	
	


· Run the Synchronize Local WF tables process every time you make changes to user setup. 

NOTE: At this point, you can save a customized workflow XYZ iExpenses Workflows to the database. If you need to recreate or update the workflows, follow the steps below. 

Define Workflow Notification Performers

Perform these steps in Oracle Workflow Builder to set up expense report performers. These steps include recommendations for which item attribute to use for

each notification. 

1. Load OIEADMIN Role.

2.  From the Files menu, select Load Roles from Database. 

3. In the Role Selection window, query the OIEADMIN role, 

4. From the Query Results region, select the required roles and click the Add button to add the role to the Loaded Roles region.
5. Click OK to save the loaded role to the database.
6. Save your work.
7. Assign Role to the attribute: From the Navigator window, open the attribute. In the Navigator Control Properties, under the Attribute tab the Type in the main region should be set to Role. In the Default region, select the proper Value (role) and click Apply. Save your work. Assign a role for each of the attributes listed in the Performer Definitions table below. 

8. Define Notification Performers. For each notification outlined in the Performer Definitions table below:
a. Open the appropriate workflow process.
b. In the workflow process, open the notification. 

c. In the Navigator Control Properties window, click the Node tab. 

d. Set Performer Type as Constant instead of Attribute.
e. Choose OIEADMIN as Value.

f. Click Apply and save your work.
Note: To directly link a role to a notification, Set Performer Type as Constant instead of Attribute. Then, select the role OIEADMIN. By using the Constant type, you have more flexibility. The table below lists the notifications, the seeded performer for each workflow process, and new performer

	Process
	Notification
	Seeded Performer
	New Performer

	Server Side Validation Process
	Inform Sys Admin of Payables Validation Failure
	AP Expense Report Workflow

Administrator
	OIEADMIN

	Manager (Spending) Approval Process
	Inform System Administrator - No Approver
	AP Expense Report Workflow

Administrator
	OIEADMIN

	Manager (Spending) Approval Process
	Inform AP Mgr Approved ShortPay With Missing Receipts
	AP
	OIEADMIN

	AP Approval Process
	Request AP To Review For Spending Policy Compliance
	AP
	OIEADMIN

	Rejection Process
	Inform AP Exp Report They Reviewed Is Mgr Rejected
	AP
	OIEADMIN

	Policy Violation Shortpay Process
	Provide AP With Missing Info To Rectify Policy Shortpay
	AP
	OIEADMIN

	
	
	
	


Change the Find Approver Method
Perform these steps in Oracle Workflow Builder to change the Find Approver method.

1) Open the ‘Expenses’ item type from the database

2) In the Navigator window, expend Expenses and Processes folders.

3) Open (double-click) the manager (Spending) Approval Process

4) Open the Find Approver function

5) In the Navigator Control Properties window, click the Node Attributes tab. 

6) In the Value field, select ‘One Stop Then Go Directly’ 

7) Click Apply and save your work.
8) Click OK to save the workflow file to the database.

Personalize Expense Report Submission Instructions

· As System Administrator: Set ‘Personalize Self-Service Defn’ to Yes.

· Log out of the system.

· Navigate to Expenses Home page (e.g. XYZ Time and Expense Entry responsibility)
· Create and submit an expense report
· In the Confirmation page, click the Personalize Submission Instructions Header link in the Submission Instructions region.

· In the Choose Personalization Context page, enter Your Company Business Group in the Organization field and click Apply. 
· In the Personalize Region page, click Personalize for the Raw Text item.

· In the Personalize Raw Text page, select False for the Rendered row at the Site level, and then click Apply.
· In the Personalize Region page, click Create Item for the Header: Submission Instructions item. 
· In the Create Item page, select the ‘Raw Text ‘ value from the Item Style list.

· Complete the page according to your business requirements:

· ID = XYZ_SUBMISSION_INSTRUCTIONS

· Text: Include following text message: Add You Company’s Submission Instructions Here.
· Click Apply

· In the Personalize Region page, click Personalize for the message you created.

· In the Personalize Raw Text page, enter a message in the Text field for the appropriate level, then click Apply.

· In the Personalize Region page, click Return to Application.
Integrating with Oracle Projects Summary
1. Enable employees to enter project-related expense reports using Internet Expenses. To enable an employee to enter project-related expense reports using Internet Expenses, set these profile options in Oracle System Administration:

a. Set PA: Allow Project Time and Expense Entry to ‘Yes’

b. Set OIE: Enable Projects to ‘Yes’.
2. Define the Project Expense Report Account Generator. The Project Expense Report Account Generator is an Oracle Projects workflow process that determines the account for each project-related expense line created in Internet Expenses. The default logic of this process returns the CCID (Code Combination ID) of the employee who incurred the project-related expenses. You can define the Project Expense Report Account Generator to meet your requirements

3. To approve project-related expense reports automatically (optional)

a. Set the PA: AutoApprove Expense Reports profile option in Oracle Projects.

4.  Set up Transaction Controls in Oracle Projects (optional). 

5. In the Payables Expense Report Templates window, define a project-related expense report template and associate a list of Projects expenditure types with expense items. (Completed during AP: Define Expense Report Template step below)
6. Compile the Expense Types Descriptive flexfield!
a. Login to the Application Developer responsibility.

b. Navigate: Application > Validation > Set
c. Query value set name 'OIE_EXPENSE_TYPES'
d. Click Edit Information
e. In the Table Columns section, for the ID column, change the Size to 30 and Save.
f. Navigate: Flexfield > Descriptive > Segments
g. Query the Title: 'Expense Report Line'
h. Freeze and compile the Expense Report Line Flexfield. Verify successful compilation. Navigate: Application -> Validation -> Set
i. Query value set name 'OIE_EXPENSE_TYPES'. Click Edit Information.

j. In the Table Columns section, for the ID column, change the Size back to 80 and Save.

7. Enable the Display of Project and Task. Use the Region Items window to enable the display of project and task information. You need to perform this step in order to view projects and tasks in View Expense Report History. 
a. Choose the AK Developer responsibility.
b. Navigate to the Define Regions window.
c. Query the region ICX_AP_EXP_LINES_D.
d. Choose Region Items to navigate to the Region Items window.
e. Query the region items ICX_PROJECT_NUMBER item (ATTRIBUTE_NAME).
f. Check the Node Display box for these region items.
g. Query the region items ICX_TASK_NUMBER item (ATTRIBUTE_NAME).
h. Check the Node Display box for these region items.
i. Save your work.
Set Up Offline Expense Spreadsheet Template

The Microsoft Excel template is a spreadsheet that employees use to create disconnected expense reports. You must configure the Microsoft Excel template so that it matches your current Internet Expenses implementation. For example, all fields in Internet Expenses must exist in your template, and fields that are set  ‘Required’ in Internet Expenses must also be required in the template. If the template does not match your implementation, employees cannot create and import expense reports using the disconnected process.

To configure the Microsoft Excel template, you must enter specific values from various Oracle Payables windows into the template. Once you have configured the Microsoft Excel Template, remove the seeded function from the menu for exporting the spreadsheet. The seeded OIE Import Page function is assigned to the Expenses Shortcuts menu.

Configure the Expense Report Sheet

This section describes how to configure the Expense Report sheet. Export the seeded Offline Spreadsheet from Expenses Home. Open the Excel file.
Displaying the Spreadsheet Tabs

After obtaining the expense spreadsheet template from the operating system directory, display the custom sheet tabs to make any modifications to expense types, headings, cell links, etc. You can modify these sheets in the Microsoft Excel template:

· Expense Report

· Currency Codes and Descriptions

· Expense Types

· Cell Links

· Prompts (to change column and cell headings)

To display the custom sheet tabs in the expense spreadsheet template:

1. Open the spreadsheet file apwexpmc.xls.

2. Choose Tools > Protection > Unprotect Sheet.

3. Choose Options from the Tools menu.

4. Open the View tab.

5. Check the Sheet Tabs box, then click OK.

Define the Date Format

Users enter a receipt date in the spreadsheet Date From column. For multiple–day receipts, users can define a range of days by entering dates in both the Date From and the Date To columns. When an employee imports a completed expense report, Internet Expenses compares the date format of the Date From and Date To columns to the date format set using the self-service applications General Preferences function. If the date formats in these columns do not match the date format specified by the General Preferences function, users must re–enter receipt dates in Internet Expenses. An example of a valid date format is DD–MON–YYYY. When a user makes changes to the General Preferences, the changes only affect that user’s login session.

Prerequisites

Determine a date format to use in the Expense Spreadsheet.

To define the date format:

1. Open the Expense Report sheet tab at the bottom of the spreadsheet.

2. Select the Date From and the Date To column, then choose Format > Cells.

3. Open the Number tab, and then choose Date as the Category.

4. Choose a date format from the list in the Type region, and then click OK.

Enter an Expense Template Name

You must assign a template name to the Microsoft Excel template to define the list of expense types that are available in Internet Expenses (for example, airfare, meals, lodging, and so on). This template also determines the expense types you can include in the Expense Types sheet in the Microsoft Excel template. 

You create expense report templates in the Payables Expense Report Templates window. The template you choose must have the Enable for Internet Expenses option checked (set to Yes). When an employee imports a Microsoft Excel expense report, Internet Expenses compares the template name to the names of all active, Internet Expenses-enabled templates. If the template name of a Microsoft Excel expense report does not match the name of an Internet Expenses-enabled template, Internet Expenses rejects the report.

To enter a template name:

1. Open the Expense Report sheet tab at the bottom of the spreadsheet.

2. Enter the name of an expense report template that is enabled for Internet Expenses into the Expense Template cell. The name must exactly match the name of an Internet Expenses-enabled template that appears in the Payables Expense Report Templates window.

3. Save your work.

Define Your Company Expense Types

To enter expense types in the Expense Report sheet, users select values from a choice list. The Expense Types sheet contains the values that appear in this choice list. You must configure the Expense Types sheet so it contains only valid expense types. Valid expense types include:

· Expense types defined in the Payables template that you identified in the Expense Report sheet. 

· Expense types with the Viewable From All Templates option checked in the Payables Expense Report Templates window.

The generic Expense Types sheet within the Microsoft Excel template includes several sample expense types. You must change the sample expense types to valid expense types and delete any rows that you do not change. To add expense types, insert new rows into the Expense Types sheet. You must insert a new row above an existing row for the expense type to appear in the choice list. After you update the Expense Types sheet, you may need to update the expense types that appear in the expense report template. (By default, the template does not display expense types.) See: Modifying Cell Links, page 6-11 for more information. When you make changes to the Expense Types sheet, you can use the Expense Report sheet to confirm your changes.

To set up expense types:

1. Open the Expense Types sheet tab at the bottom of the spreadsheet.

2. Change the sample expense types to valid expense types (those defined in the template you entered in the Expense Report sheet). You must spell each expense type exactly as it appears in the Payables Expense Report Templates window.

3. To add an expense type, insert a new row and enter the name of the expense type exactly as it appears in the Payables Expense Report Templates window. To insert a new row, select a cell that contains a value, then choose Insert > Rows. If you select a cell that does not contain a value and use Insert > Rows to add an expense type to this new row, the expense type does not appear in the choice list. 

Note: Do not edit the header region (cells A1 and A2) of the Expense Types sheet.

Note: Sort the list of expense types alphabetically. To do this, select the rows to sort, then click on the Sort Ascending button (or choose Data > Sort, click on Ascending, then click OK).

4. Open the Expense Report sheet tab at the bottom of the spreadsheet to review the expense report and verify your changes.

5. Save your work.

Testing a New Custom Microsoft Excel Template

Before releasing your custom template for general use, import and validate the spreadsheet in Internet Expenses. Perform these steps to discover and resolve any remaining setup problems that may exist in your template. 

To test the Custom Microsoft Excel Template:

1. Compare the custom Microsoft Excel template and expense types to the Corporate Credit Card and Cash and Other Expenses pages. Ensure all fields in the template appear in these pages, and all the fields on these pages appear in the template. (Be sure that you also look at the Expense Details page.) 

2. Create an expense report with the custom Microsoft Excel template. Assign each expense type to at least one receipt.

3. Upload the expense report. Make sure the message you entered at the bottom of the spreadsheet template appear in the Spreadsheet Upload Area. 

4. Click Next to validate the spreadsheet. You must fix errors that exist in the spreadsheet template itself before releasing it to employees for general use. Errors that occur because the spreadsheet was incorrectly defined can be fixed only by the system administrator. Errors that occur due to missing or invalid data in the spreadsheet do not indicate a serious problem and the report can still be imported into Internet Expenses. When expense report information is missing or invalid, you can perform either of these actions:

· Click Clear or Cancel to fix the errors in Microsoft Excel, then import it again later.

Save the spreadsheet to the database
To save the customized spreadsheet to the database:

1. Configure the spreadsheet according the instructions above.
2. Save the spreadsheet XYZ_APWEXPMC.xls to the $OA_HTML/US directory.
3. Log into the System Administration responsibility.
4. Navigate to the Form Functions window. 
5. Query up function AP_WEB_DOWNLOAD.
6. Click on Web HTML tab.

7. Replace value in the HTML Call to ‘US/XYZ_APWEXPMC.xls’
8. Save.
To verify if the customized spreadsheet is saved:

· Navigate to iExpenses, Expenses Home 
· Click on Export Spreadsheet
· The File Download window should pop-up, and name should be XYZ_APWEXPMC.xls
Other Configuration Considerations

· Make sure all expense approving managers are set up as Oracle users. 
· Make sure every employee is assigned to one Oracle user only.

· Submit the ‘Synchronize WF LOCAL tables’ process to run daily to update the Workflow resource information

Open and Closed Issues 
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